Parallels Management Console

Getting Started Guide
CHAPTER 1

Introduction

This guide provides information on how to start working in Parallels Management Console - a client application used to manage your physical servers and their virtual machines.

In This Chapter

About Parallels Management Console ................................................................. 5
About This Guide ............................................................................................... 6
Getting Help ....................................................................................................... 7
Feedback ........................................................................................................... 8
About Parallels Management Console

Parallels Management Console is a remote tool with a graphical user interface (GUI) for managing your physical servers and virtual machines residing on them. This tool supports managing physical servers running the following Parallels products:

- Parallels Server for Mac
- Parallels Server Bare Metal
- Parallels Server Bare Metal Xserve Edition

**Note:** In this guide, the information about Parallels Server Bare Metal refers both to Parallels Server Bare Metal and to Parallels Server Bare Metal Xserve Edition.

Parallels Management Console uses a typical client-server architecture.

The client application with the graphical user interface is installed on a computer running one of the supported Linux, Mac, or Windows operating systems. For the full list of supported operating systems, see the **Checking System Requirements** subsection of the **Getting Started With Parallels Management Console** user's guide. Once the client application is up and running, it can connect to the Parallels Service software on a physical server. This software is automatically installed on the physical server when you install one of the aforementioned Parallels products. The client application can control multiple physical servers simultaneously (e.g. *Physical Server #1* and *Physical Server #2* as shown in the picture above). After the connection to the required physical server has been established, you can start managing this server and its virtual machines using the intuitive and comfortable GUI.
About This Guide

The *Getting Started With Parallels Management Console* guide provides information on installing and setting to work the Parallels Management Console application on your computer.

The guide is aimed at anyone planning to use Parallels Management Console for managing their physical servers and virtual machines. To follow the instructions in this guide, no more than basic Linux, Mac, or Windows administration skills are required.

Organization of This Guide

This guide is organized in the following way:

- **Chapter 1, Introduction**, gives an overview of Parallels Management Console and this guide.
- **Chapter 2, Setting Parallels Management Console to Work**, describes the requirements your computer must meet to successfully install Parallels Management Console on it. It also provides instructions on how to install this application and start working in it.
- **Chapter 3, Performing Basic Operations in Parallels Management Console**, familiarizes you with the way to perform the main operations on your virtual machines using Parallels Management Console.

Documentation Conventions

Before you start using this guide, it is important to understand the documentation conventions used in it.

The table below presents the existing formatting conventions.

<table>
<thead>
<tr>
<th>Formatting convention</th>
<th>Type of Information</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Bold</td>
<td>Items you must select, such as menu options, command buttons, or items in a list.</td>
<td>Go to the <strong>Resources</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>Titles of chapters, sections, and subsections.</td>
<td>Read the <strong>Basic Administration</strong> chapter.</td>
</tr>
</tbody>
</table>
**Introduction**

Italics

Used to emphasize the importance of a point, to introduce a term or to designate a command-line placeholder, which is to be replaced with a real name or value.

These are the so-called *EZ templates.* To destroy a Container, type `vzctl destroy ctid`.

Monospace

The names of commands, files, and directories.

Use `vzctl start` to start a Container.

Preformatted

On-screen computer output in your command-line sessions; source code in XML, C++, or other programming languages.

Saved parameters for Container 101

Monospace Bold

What you type, as contrasted with on-screen computer output.

# rpm -V virtuozzo-release

Key+Key

Key combinations for which the user must press and hold down one key and then press another.

Ctrl+P, Alt+F4

Besides the formatting conventions, you should also know about the document organization convention applied to Parallels documents: chapters in all guides are divided into sections, which, in their turn, are subdivided into subsections. For example, *About This Guide* is a section, and *Documentation Conventions* is a subsection.

**Getting Help**

In addition to this guide, you can refer to the following resources to get more information on Parallels Management Console:

- *Parallels Management Console User's Guide.* This guide contains extensive information on configuring Parallels Management Console settings and using this application to manage physical servers and Parallels virtual machines. To open the guide, choose *Parallels Management Console User's Guide* from the Parallels Management Console Help menu.

- Context-sensitive help. When working in Parallels Management Console, you can open a help page for the currently active window by pressing F1 on your keyboard.

- Online documentation. All documentation for Parallels Management Console and other Parallels products, such as Parallels Server Bare Metal and Parallels Server for Mac, is also available online.


- Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprises various articles about using Parallels Management Console and other Parallels products.
Feedback

If you spot a typo in this guide, or if you have thought of a way to make this guide better, you can share your comments and suggestions with us by completing the feedback form at the Parallels documentation feedback page (http://www.parallels.com/en/support/usersdoc/).
This chapter describes the requirements your computer must meet to successfully install Parallels Management Console on it. It also provides instructions on how to install this application and start working in it.

In This Chapter

Checking System Requirements ................................................................. 10
Obtaining Parallels Management Console ................................................... 12
Installing Parallels Management Console .................................................... 13
Exploring Parallels Management Console Interface ...................................... 15
Connecting to a Server ............................................................................. 18
Uninstalling Parallels Management Console ............................................... 19
Checking System Requirements

Parallels Management Console can be installed on any computer that meets the following requirements:

**Hardware Configuration**

- Intel-powered Mac with Core™ Duo or Core™ Solo processor or a PC with 700+ MHz Intel-compatible x86 or x64 processor
- 1 GB of RAM
- 100 MB of hard disk space for Parallels Management Console installation files
- Ethernet or WiFi network adapter

**Compatible Operating Systems**

Ubuntu 7.04 (x32, x64)
Ubuntu 7.10 (x32, x64)
Ubuntu 8.04 (x32, x64)
Ubuntu 8.10 (x32, x64)
Fedora 8 (x32, x64)
Fedora 9 (x32, x64)
Fedora 10 (x32, x64)
Debian 4.0 (x32, x64)
Mandriva 2007 (x32, x64)
Mandriva 2008 (x32, x64)
Red Hat Enterprise Linux WS4 (x32, x64)
Red Hat Enterprise Linux AS4 (x32, x64)
Red Hat Enterprise Linux ES4 (x32, x64)
Red Hat Enterprise Linux 5 (x32, x64)
CentOS 4.x (x32, x64)
CentOS 5.0 (x32, x64)

CentOS 5.1 (x32, x64)

SUSE® Linux Enterprise Server 10 SP1 (x32, x64)

SUSE 10 (x32, x64)

SUSE 11 (x32, x64)

Windows Server 2003 Standard Edition SP2, R2 (x32, x64)

Windows Server 2003 Enterprise Edition SP2, R2 (x32, x64)

Windows 2003 Home Server (x32, x64)

Windows XP Professional Edition SP2 (x32, x64)

Windows Vista® Ultimate (x32, x64)

Mac OS X v10.6 Snow Leopard

Mac OS X v10.5.2 Leopard or later

Mac OS X v10.4.11 Tiger
Obtaining Parallels Management Console

Follow these steps to obtain the Parallels Management Console installation file:

1. Ensure that the Parallels server (i.e. the physical server running Parallels Server Bare Metal) can be accessed over the network.

2. On a computer connected to the network, open your favorite browser, and type the IP address or hostname of the Parallels server. You will be presented with the following window.

3. Click the link corresponding to your system architecture:
   - **For Windows.** Click this link to download the Parallels Management Console installation file for installing on Windows computers.
   - **For Linux.** Click this link to download the Parallels Management Console installation file for installing on Linux computers.
   - **For Mac.** Click this link to download the Parallels Management Console installation file for installing on Mac computers.

4. Download the file.

5. If you plan to install Parallels Management Console on another computer, transfer the file to that computer.
Installing Parallels Management Console

The process of installing Parallels Management Console differs depending on the operating system installed on your computer.

Installing on Windows Computers

1. Locate the Parallels Management Console installation file and double-click it to launch the Parallels Management Console Setup wizard.

2. In the Welcome window, click Next.

3. In the License Agreement window, carefully read the end user license agreement for Parallels products. If you agree with the terms of the license agreement, select I accept the terms in the license agreement and click Next. If you want to print the text of the license agreement for your records, click Print.

   Note: You must accept the license agreement to proceed with the installation.

4. In the Destination Folder window, specify the folder where you want to install Parallels Management Console, and click Next. By default, Parallels Management Console is installed to C:\Program Files\Parallels\Parallels Management Console.
5 In the **Ready to Install the Program** window, click **Install** to start installing Parallels Management Console. You can view the installation progress in the **Setup Status** window.

6 Once the installation is complete, click **Finish** to exit the wizard.

### Installing on Linux Computers

1 Locate the installation package and launch the `parallels-management-console-4.0.XXXX.XXXXX.run` file to run the Parallels Management Console Installer. You can also run this file in terminal.

2 Confirm your wish to install Parallels Management Console by clicking **Run** when prompted.

   Wait until the process of uncompressing Parallels Management Console is complete and the Installer launches.

3 In the **Welcome** window, select **Next**.

4 In the **License Agreement** window, carefully read the end user license agreement. If you agree with the terms of the license agreement, select **I accept the terms in the license agreement** and click **Next**. If you want to print the text of the license agreement for your records, click **Print**.

   **Note:** You must accept the license agreement to proceed with the installation.

5 In the **Installation Completed** window, click **Exit** to quit the Installer.

   By default, Parallels Management Console is installed to `/usr/lib/parallels-management-console`. To launch Parallels Management Console, start a terminal and execute `pmc-standalone`.

### Installing on Mac Computers

1 Locate and open the Parallels Management Console DMG package.

2 Drag the **Parallels Management Console** icon to the **Applications** folder. The recommended installation path for Parallels Management Console is `/Applications/Parallels Management Console`.

3 Wait while the files are being transferred to the **Applications** folder.
Exploring Parallels Management Console Interface

Parallels Management Console main window displays general information about the registered Parallels servers and their virtual machines.

The main window consists of the following parts: the toolbar, the sidebar, the summary pane, and the status bar.
Toolbar

Parallels Management Console toolbar has buttons for the most frequently used commands:

- **Shut Down** button. Use this button to turn off the virtual machine.
- **Suspend** button. Use this button to put your virtual machine into sleep mode. For example, if you need to restart the Parallels server, you can temporarily suspend your virtual machines and easily resume them after the restart.
- **Pause** button. Use this button to pause the virtual machine. Use this button when you need to instantly release the server resources used by this virtual machine to another virtual machine. **Note:** If you stop a paused virtual machine, you will not be able to continue working with it from the moment it was paused. To be able to stop the virtual machine and to save all the data in it, you should suspend it using the **Suspend** button.
- **Start** button. Use this button to start the virtual machine if it is stopped, paused, or suspended.
- **Detach Console (Attach Console)** button. Use this button to detach the virtual machine console to a new window or to attach it back to the main window. You may use this button to view the currently running virtual machines in separate windows.
- **Server level** button. Use this button to quickly switch from the virtual machine summary pane to the summary pane of the server this virtual machine belongs to.

You can easily add additional buttons to the toolbar:

1. Right-click the toolbar, and choose **Customize Toolbar** from the shortcut menu.
2. Drag the items you need to the toolbar.
3. Click **Done**.

Sidebar

The sidebar displays the registered servers and all virtual machines hosted on them.

Summary Pane

The summary pane displays the basic information about the server or the virtual machine currently selected in the sidebar.

When a server is selected, the summary pane has three tabs:

- **Summary**. Click this tab to view the general settings of the selected server, the list of virtual machines hosted on it, and the operations you can perform on the server.
- **Performance**. Click this tab to view the current resources consumptions on the server.
- **Backup**. Click this tab to view and manage the backups stored on the server.
When a virtual machine is selected, the summary pane has three tabs:

- **Summary.** Click this tab to view the general settings of the selected virtual machine, its configuration, and the list of actions you can perform on this virtual machine.

- **Console.** Click this tab to view the display of the virtual machine that is currently running. This tab is available only when the virtual machine is running.

- **Performance.** Click this tab to view how much of the server resources the selected virtual machine is using.

- **Backup.** Click this tab the view and manage the backups of the selected virtual machine.

**Status Bar**

The status bar becomes active, when you start a virtual machine. It displays the virtual machine devices icons when you click the Console tab or switch the virtual machine console to detached mode. You can easily connect or disconnect the devices using the icons on this bar: right-click the device icon and choose the necessary option from the shortcut menu.
Connecting to a Server

Now that you have installed Parallels Management Console, you can connect to the physical server where Parallels Server Bare Metal is installed. Do the following:

1. Launch Parallels Management Console:
   - On Mac OS X, open the /Applications/Parallels folder and launch the Parallels Management Console application.
   - On Windows, click Start > All Programs > Parallels > Parallels Management Console > Parallels Management Console.
   - On Linux, start a terminal and execute pmc-standalone.

2. In the Parallels Management Console main window, click Connect to Parallels Server.

3. In the Parallels Server Login dialog, specify the parameters to be used to log in to the physical server running Parallels Server Bare Metal:
   - In the Server list, type the IP address or hostname of the physical server.
   - In the User Name field, type root. You must use the root account to log in to the physical server.
   - In the Password field, type the password for the root user. Use the password you specified when installing Parallels Server Bare Metal on the physical server.

   If you want Parallels Management Console to remember your login and password, select the Save Password option. With this option selected, you do not need to specify the root credentials each time you connect to the server.

4. Click Add Server to establish connection to the physical server.

After the server has been successfully registered in Parallels Management Console, it appears in the left menu of the Parallels Management Console main window. For further information on using Parallels Management Console to manage Parallels Server Bare Metal and virtual machines, refer to the Parallels Management Console User's Guide.
Uninstalling Parallels Management Console

Use these procedures to remove Parallels Management Console from your computer.

**On Windows computers**

Parallels Management Console can be removed from a Windows computer like any other Windows application:

1. From the Start menu, choose Control Panel and then double-click Add or Remove Programs.
2. Select Parallels Management Console and click Remove.

**On Linux computers**

Parallels Management Console can be removed from a Linux computer like any other Linux application:

*Note: To remove Parallels Management Console, you must have the root privileges.*

1. Locate the Parallels Management Console installation package and execute the parallels-management-console-4.0.XXXX.XXXX.run file to run the Parallels Management Console installation program.
2. In the Welcome window, press Enter.
3. Select Remove and press Enter.

When Parallels Management Console is successfully uninstalled, press Enter to close the Parallels Management Console uninstaller.

**On Mac computers**

Parallels Management Console can be removed from a Mac computer like any other Mac application:

1. Locate the Parallels Management Console icon.
2. Right-click the icon and choose Move to Trash.
This chapter outlines the basic day-to-day operations that you are likely to perform with Parallels virtual machines in Parallels Management Console.

**In This Chapter**

Creating a Virtual Machine ................................................................................................... 20  
Configuring a Virtual Machine ............................................................................................. 30  
Managing Virtual Machines .................................................................................................. 31  
Managing Virtual Machine Templates .................................................................................. 38

---

**Creating a Virtual Machine**

Before you can start managing a virtual machine, you first need to create it. The process of creating a ready-to-use virtual machine includes these steps:

1. **Creating a virtual machine configuration.** In this step, you choose and configure the virtual hardware for the virtual machine (disk drives, CD/DVD-ROMs, network cards, and so on).

2. **Installing a guest operating system.** In this step, you choose and install the operating system (called the guest operating system or the guest OS) in the virtual machine.

   To check the list of supported guest operating systems available for Parallels Server for Mac, refer to *Parallels Server for Mac User's Guide*.

   To check the list of supported guest operating systems available for Parallels Server Bare Metal, refer to *Parallels Server Bare Metal User's Guide*.

3. **Installing Parallels Tools.** You are also recommended to install Parallels Tools in your virtual machine. They will make your work with the virtual machine more comfortable. For more information on Parallels Tools, refer to *Installing Parallels Tools* (p. 24).

The following subsections describe all these steps in detail.
Creating a Virtual Machine Configuration

Parallels Management Console allows you to create a virtual machine using one of the following modes:

- **Express.** In this mode, Parallels Management Console does the following:
  a. Creates a virtual machine with the configuration typical for the guest operating system you select for installing in this virtual machine.
  b. Installs the selected guest OS in the newly created virtual machine.


- **Typical.** In this mode, Parallels Management Console creates a virtual machine with the configuration typical for the operating system you select for installing in this virtual machine. But unlike the Express mode, the selected guest OS is not automatically installed in the newly created virtual machine.

- **Custom.** In this mode, you control the whole process of the virtual machine creation:
  - First, you specify the parameters for creating the virtual machine configuration.
  - Second, you install the appropriate guest operating system in the virtual machine.

The example below demonstrates the process of creating a virtual machine using the Typical mode. For information on creating virtual machines using the Express and Custom modes, refer to *Parallels Management Console User's Guide*.

To create a virtual machine in the Typical mode, do the following:

1. Launch Parallels Management Console.
2. If you have more than one physical server registered in Parallels Management Console, select the server where you want to host the new virtual machine.
3. Start the **New Virtual Machine** wizard by doing one of the following:
   - Choose **New Virtual Machine** from the **File** menu.
   - Click **New Virtual Machine** on the server **Summary** tab.
   - Right-click the server icon in the sidebar and choose **New Virtual Machine**.
4. In the **Select Operating System Type and Version** window, select the operating system you want to install in the virtual machine, and click **Continue**.
   If you cannot find the necessary operating system in the list, select **Other**.
5. In the **Virtual Machine Type** window, select **Typical**, and click **Continue**.
6. In the **Name and Location** window, type an arbitrary name for the virtual machine and specify the folder for storing its files. By default, all virtual machine files are placed to the following folders:
   - On **Mac** computers:
     /Users/Shared/Parallels/<Virtual_Machine_Name>/.
   - On servers running Parallels Server Bare Metal: /var/Parallels.
When you are ready, click Create.

7 Once the virtual machine configuration is created, the Prepare to Install Operating System window appears.
In this window you can do the following:

- Start installing the guest operating system in the newly created virtual machine:
  
  a Select the installation source in the Placement list. Choose Physical Server if your source installation files are located on the remote Parallels server; otherwise, choose Client Computer.

  b Specify the path to the source installation files. Select Real CD/DVD-ROM Drive to use a disc inserted into the CD/DVD drive of the computer. Choose the drive to use from the Drive list. Select CD/DVD Image to use a CD/DVD disc image connected to the virtual machine's CD/DVD drive. Type the path to the file in the File field or use the Choose button to locate the file.

  c Click Start to start the newly created virtual machine and launch the guest operating system installation.

- Quit the wizard without installing the guest operating system in the newly created virtual machine. To do this, click Done.

Installing a Guest Operating System

After you have created the virtual machine configuration, you need to install a guest operating system (unless you are creating the virtual machine in the Express mode where the guest operating system is installed automatically without your interaction). The guest operating system installation automatically starts if you do the following:

- Specify the path to the source installation files in the Prepare to Install Operating System window of the New Virtual Machine wizard, and click Start.

- Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog. In this dialog, click the Hardware tab, select CD/DVD 1 in the left pane, choose the installation source in the Source list, and click OK. Start the virtual machine.

Note: You can install a guest operating system only from the CD/DVD-ROM 1 drive.

You can also install a guest operating system using a PXE server.

1 Make sure that the virtual machine is connected to the same network to which the PXE server belongs.

2 Click the name of the virtual machine in the left pane of Parallels Management Console.

3 Click Configure to open the Virtual Machine Configuration dialog.

4 On the Hardware tab, click Boot Order.

5 Move the Network Adapter item to the top of the boot sequence, and click OK.

  Note: The virtual machine will use the network adapter specified as Network Adapter 1 in this virtual machine configuration.

6 Start the virtual machine.

Once the installation program is launched, follow the on-screen instructions to install your guest operating system in the virtual machine. This procedure does not differ from installing Windows, Linux, or Mac on a standalone computer.
**Installing Parallels Tools**

Parallels Tools are a suite of special utilities that help you use your virtual machines in the most comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly outside the guest OS window without pressing any key, change the virtual machine's screen resolution by simply resizing its window, and synchronize your virtual machine's time and date settings with the time settings of the physical server.

The process of installing Parallels Tools differs depending on the guest operating system running inside your virtual machine. The subsections below describe the mains steps for installing Parallels Tools on Linux, Mac, and Windows. For more information on Parallels Tools, see the *Parallels Management Console User's Guide*. 
Installing Parallels Tools in Mac OS X

To install Parallels Tools in a Mac guest OS X, do the following:

1. Start the virtual machine and log in to the guest OS.
2. Choose the Install Parallels Tools option from the Virtual Machine menu. This will connect and mount the Parallels Tools ISO image file (prl-tools-mac.iso) to the first CD/DVD-ROM in the virtual machine configuration.

   **Note:** If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are supported by your guest operating system. For the full list of supported guest OSs, refer to Parallels Management Console User's Guide.

3. In the displayed window, read the brief information about Parallels Tools and click Continue.
4. Open the mounted image and double-click Install to start the installation.
5. In the Welcome window, click Continue.
6. In the Select a Destination window, specify the location for storing Parallels Tools files and click Continue.
7 In the **Standard Install on "Macintosh HD"** window, click **Install** (when prompted, type your password). You can also use the **Change Install Location** button to configure the location of the Parallels Tools files.

You can view the process of installing Parallels Tools in the **Installing Parallels Guest OS Tools** window.

8 Once the installation is complete, click **Restart** to exit the installer and restart the virtual machine.

**Troubleshooting**

If the Parallels Tools ISO image file was not automatically connected to the virtual machine's CD/DVD-ROM drive, you can connect it manually:

1 Right-click the CD/DVD-ROM drive icon in the status bar of the virtual machine window, and select **Configure**.

2 In the **Source** field, click the up or down arrow, and select **Choose an image file**.

3 In the displayed window, specify the location of the Parallels Tools ISO image file (by default, it is located in `/Library/Parallels/Tools` on your Mac) and click **Open**.

4 Select the **Connected** option and click **OK**.
Installing Parallels Tools in Windows

To install Parallels Tools in a Windows guest operating system, do the following:

1. Start the virtual machine and log in to the guest OS.
2. Choose the Install Parallels Tools option from the Virtual Machine menu. This will connect the Parallels Tools ISO image (*prl-tools-win.iso*) to the virtual machine's CD/DVD-ROM drive and start the Parallels Tools installer.

   **Note:** If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are supported by your guest operating system. For the full list of supported guest OSs, see Parallels Management Console User's Guide.

3. In the Welcome window, click Install to install Parallels Tools. The installation also starts automatically after several seconds even if you do not click the Install button.

4. Once the installation is complete, click Reboot to exit the wizard and restart the virtual machine.

Troubleshooting

If the installation of Parallels Tools does not start automatically after performing the steps above, start it manually. To do this:

1. Right-click the CD/DVD-ROM drive icon in the status bar of the virtual machine window and select Configure.

2. In the Source field, click the up or down arrow and select Choose an image file.

3. In the displayed window, specify the location of the Parallels Tools ISO image file (by default, it is located in /Library/Parallels/Tools on your Mac), and click Open.

4. Select the Connected option and click OK.

If this does not help, do the following:

1. In the guest OS, open My Computer.
2. Double-click the CD/DVD-ROM icon.
3. Locate the *setup.exe* file, and double-click it.
Installing Parallels Tools in Linux

Before installing Parallels Tools in a Linux guest operating system, do the following:

- Close all applications in the guest OS.
- Disable the 3D-accelerated window manager, if you use any.
- Make sure that you have the gcc package and the appropriate kernel-sources package installed. If these packages are not installed, you will see a warning message when installing Parallels Tools. The name of the kernel-sources package differs depending on the Linux guest OS. It can be called kernel-devel, kernel-headers, or something like this.

Note: To install Parallels Tools in a virtual machine, you must have the root privileges.

Installing Parallels Tools in the Modern Linux Distributions

If your virtual machine is running one of the most recent versions of Linux OSs (e.g. Fedora 11), the Parallels Tools ISO image (prl-tools-lin.iso) will be automatically mounted after you connect the image to the CD/DVD-ROM drive. To install Parallels Tools, do the following:

1. Start the virtual machine, and log in to the guest OS.
2. Choose Install Parallels Tools from the Virtual Machine menu. This will connect and mount the prl-tools-lin.iso image file to the virtual machine's CD/DVD-ROM drive.

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are supported by your guest operating system. For the full list of supported guest OSs, see the Parallels Management Console User's Guide.

3. Start a terminal, and run the following command to gain the root privileges:

   su

4. Change the directory to the CD/DVD-ROM directory using

   cd /media/cdrom/

   Note: In some of the Linux operating systems, the mount point for the virtual CD/DVD-ROM drive may appear as /media/Parallels Tools.

5. In the CD/DVD-ROM directory, enter the following command to launch Parallels Tools installation:

   ./install

6. Follow the instructions on the screen to complete the installation.

7. When the installation of Parallels Tools is complete, restart your virtual machine.

Installing Parallels Tools in other versions of Linux guest OSs

To install Parallels Tools in older versions of Linux OSs, you have to mount the prl-tools-lin.iso image file manually:

1. Start the virtual machine.

2. When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels Tools.
Performing Basic Operations in Parallels Management Console

**Note:** If the **Install Parallels Tools** option is grayed out, make sure that Parallels Tools are supported by your guest operating system. For the full list of supported guest OSs, see the *Parallels Management Console User's Guide*.

The **prl-tools-lin.iso** image file will be connected to the virtual machine's CD/DVD-ROM drive.

3. Start a terminal in your Linux guest OS. Type the following command to gain the **root** privileges:

```
su
```

4. Check if the Parallels Tools CD image is mounted by executing the following command:

```
mount | grep iso9660
```

- If this command does not produce any output, proceed to **Step 5**.
- If this command returns something like
  
  `/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0),`
  
  skip **Step 5** and proceed to **Step 6**.
- If this command returns something like
  
  `/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0)`
  
  with the **noexec** option present in parentheses, unmount the disc using the following command and then proceed to **Step 5**:

```
umount /dev/cdrom
```

5. To mount the Parallels Tools installation disc image, run this command:

```
mount -o exec /dev/cdrom /media/cdrom
```

**Note:** `/dev/cdrom` is the virtual machine's CD/DVD-ROM drive, and `/media/cdrom` is the mount point for this device. In some Linux operating systems, the virtual CD/DVD-ROM drive may appear as `/dev/hdb`, and the mount point may be `/mnt/cdrom`. Some Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create a mount point manually.

6. When the installation disc image is mounted, change to the CD/DVD-ROM directory:

```
cd /media/cdrom/
```

7. In the CD/DVD-ROM directory, execute the following command to launch Parallels Tools installation:

```
./install
```

**Note:** You must have the **root** privileges to run this command.

8. Follow the instructions on the screen to complete the installation.

When the installation of Parallels Tools is complete, restart your virtual machine.
Configuring a Virtual Machine

To edit the settings of a virtual machine and the devices it uses, you can use the Virtual Machine Configuration dialog. To open this dialog, do one of the following:

- double-click the virtual machine in the Parallels Management Console sidebar
- click Configure in the Operations section of the virtual machine Summary tab
- choose Configure from the Virtual Machine menu
- right-click the virtual machine in the sidebar and choose Configure from the shortcut menu

The Virtual Machine Configuration includes two panes:

- the sidebar displaying virtual machine options and devices available for editing
- the settings pane displaying the settings for the option or device selected in the sidebar

In the Virtual Machine Configuration dialog, you can configure the virtual machine as follows:

- Edit the settings of a specific group of options or a device by selecting its name and configuring the necessary parameters.
- Add a new device to the virtual machine's configuration or remove an existing one from it using the Add  and Remove  buttons below the sidebar.

For detailed information on configuring the virtual machine settings, see Parallels Management Console User's Guide.
Managing Virtual Machines

This section provides information on the main day-to-day operations you are likely to perform on your virtual machines:

- starting and stopping a virtual machine (p. 31)
- pausing and suspending a virtual machine (p. 32)
- switching view modes (p. 33)
- cloning a virtual machine (p. 34)
- adding an existing virtual machine to Parallels Management Console
- deleting a virtual machine (p. 36)

Starting and Stopping a Virtual Machine

To start a virtual machine, do one of the following:

- click the Start button in the toolbar
- choose Start from the Virtual Machine menu
- right-click the virtual machine in the sidebar and choose Start from the shortcut menu
- click Start in the Operations section of the virtual machine Summary tab

To stop a virtual machine, use the standard shut down procedure that is typical for its guest operating system. If you cannot shut down the guest OS properly, stop the virtual machine using one of these ways:

- click the Stop button in the toolbar
- choose Stop from the Virtual Machine menu
- right-click the virtual machine in the sidebar and choose Stop from the shortcut menu
Pausing and Suspending a Virtual Machine

If you do not want to spend much time on stopping your virtual machine, you can either pause or suspend it. Pausing a virtual machine is convenient when you need to instantly release resources the virtual machine uses. Suspending a virtual machine is convenient when you need to freeze and save the processes in the virtual machine for a long period of time.

To pause a virtual machine, do one of the following:

- click the Pause button in the toolbar
- choose Pause from the Virtual Machine menu
- right-click the virtual machine in the sidebar and choose Pause from the shortcut menu
- click Pause in the Operations section of the virtual machine Summary tab

To suspend a virtual machine, do one of the following:

- click the Suspend button in the toolbar
- choose Suspend from the Virtual Machine menu
- right-click the virtual machine icon in the sidebar and choose Suspend from the shortcut menu
- click Suspend in the Operations section of the virtual machine Summary tab

To resume a suspended or paused virtual machine, do one of the following:

- click the Resume button in the toolbar
- choose Resume from the Virtual Machine menu
- right-click the virtual machine in the sidebar and choose Resume from the shortcut menu
Switching View Modes

Parallels Management Console provides several view modes to make your work with virtual machines easier and more efficient.

- **Window.** It is the default view mode. Using this mode, you can see the virtual machine screen in the Parallels Management Console window or in a detached console window.
- **Full Screen.** Using this mode, you can expand the virtual machine screen up to the size of your computer screen.
- **Detached Console.** Using this mode, you can view the virtual machine screen in a separate window.

For switching between these modes, you can use the menu commands or toolbar buttons.

**Switching to the Full Screen mode**

You can run a guest operating system in full screen when the guest OS window occupies the whole screen of your computer and the Parallels Management Console controls are hidden.

To switch to the Full Screen mode, do one of the following:

- click the **Full Screen** button in the toolbar
- choose **Full Screen** from the **View** menu
- use the hot key kombination that is Ctrl+Alt+Enter by default

To exit the Full Screen mode and return to the Window mode, press the hot key kombination that coincides with the combination for switching to the Full Screen mode (Ctrl+Alt+Enter by default).

**Switching to the Detached Console mode**

If you have a number of virtual machines, you can run each of them in its own window by detaching their windows from the main window of Parallels Management Console.

To detach the virtual machine window, do one of the following:

- click the **Detach Console** button in the toolbar
- choose **Detach Console** from the **View** menu

To attach the virtual machine window back, do one of the following:

- close the detached window
- click the **Attach Console** button in the toolbar
- choose **Attach Console** from the **View** menu
Cloning a Virtual Machine

If you need to create an exact copy of a virtual machine, to back it up, or for some other purposes, use Clone Virtual Machine Assistant (or Clone Virtual Machine Wizard if Parallels Management Console is installed on a Windows- or Linux-based physical computer).

Using Clone Virtual Machine Assistant, you can clone a virtual machine, its virtual hard disk(s), and configuration file.

The cloned virtual machine has the same configuration as the original virtual machine does. If a device in the original machine was connected to an external resource, in the cloned virtual machine this device will be connected to the same external resource.

Notes:

1. If the original virtual machine has a printer or serial port connected to an output file, the virtual machine clone will have empty output files.

2. If a network adapter is enabled in the original configuration, a new MAC address will be generated for the virtual machine clone.

Before you start cloning a virtual machine, make sure that the virtual machine is not running.

To clone a virtual machine:

1. In the Parallels Management Console sidebar, select the virtual machine you want to clone.
2. Start Clone Virtual Machine Assistant by doing one of the following:
   - choosing Clone from the Virtual Machine menu
   - clicking Clone in the Operations section of the virtual machine Summary tab
3. In the Name and Location window, type the name of the virtual machine clone and specify the folder for its files to be stored. You can use the Choose button to locate the folder.

By default, the files of the virtual machine clone will be placed to the following folder:

- on Mac OS X host: /Users/Shared/Parallels/<Virtual Machine Name>/
- on servers running Parallels Server Bare Metal: /var/parallels/<Virtual Machine Name>
- on servers running Parallels Server Bare Metal Xserve Edition: /var/parallels/<Virtual Machine Name>
To make the Windows security identifier (SID) of the cloned virtual machine different from that of the initial virtual machine, select **Change Windows SID**. It will help you to avoid possible security problems.

Click **Clone** to start cloning the virtual machine.

4 When the operation is complete, click **Done** in the **Cloning Finished** window.

The clone of the virtual machine will appear in the sidebar of the Parallels Management Console window.
Deleting a Virtual Machine

If you do not need some of your virtual machines anymore, you can either delete them or temporarily remove from the virtual machines list:

- Deleting a virtual machine means permanently erasing its files from the host computer. Make sure you transferred all the necessary data from the virtual machine before deleting it: this operation is irreversible. All the virtual machine data will be lost.
- Removing a virtual machine from the list displayed in the Parallels Management Console window. By removing a virtual machine from the list, you do not remove the virtual machine files from the host computer.

You can delete a virtual machine using Delete Virtual Machine Assistant (or Delete Virtual Machine Wizard if Parallels Management Console is installed on a Windows- or Linux-based physical computer). By default, the assistant removes all the files stored in the virtual machine folder, including the configuration file, virtual hard disk files, floppy disk image files, and output files of serial and printer ports.

To delete a virtual machine or remove it from the list:

1. Launch Parallels Management Console.
2. In the sidebar, select the virtual machine you want to delete or remove from the list.
3. Start Delete Virtual Machine Assistant by doing one of the following:
   - choose Remove from the File menu
   - click Remove in the Operations section of the virtual machine Summary tab
   
   Note: Before deleting a virtual machine, make sure that the virtual machine is stopped.
4. In the Delete Options window, select the operation you want to perform on the virtual machine.
   - To delete the virtual machine, select Delete and click Continue.
   - To remove the virtual machine from the list, select Remove from list and click Remove.
5 If you chose to delete the virtual machine, you will be presented with the Files Selection window. The assistant displays all the files that belong to the virtual machine.

![Delete Virtual Machine Wizard](image)

Choose the virtual machine files you want to delete and click Delete.

6 When the operation is complete, click Done to exit the assistant.
Managing Virtual Machine Templates

If you need to create several virtual machines with a similar configuration, you can create a virtual machine template and use it to create new virtual machines.

To create a virtual machine template, you can use one of these ways:

- Convert an existing virtual machine into a virtual machine template. In this case, the virtual machine will be moved from the virtual machines list to the templates list once the conversion is complete. It means that the virtual machine will be available as a template only (e.g. you will not be able to run it).
- Clone an existing virtual machine to a virtual machine template. By cloning a virtual machine, you create its exact copy and can use it to create virtual machines with the same configuration.
Creating a Virtual Machine Template

To convert an existing virtual machine into a template:

1. Choose the virtual machine you want to convert into a template by clicking its icon in the sidebar.
2. Choose **Convert to Template** from the **Virtual Machine** menu or right-click the virtual machine icon in the sidebar and choose **Convert to Template** from the shortcut menu.

Once the conversion is complete, the virtual machine is moved to the Templates list.

To clone a virtual machine to a template:

1. Launch Parallels Management Console.
2. In the sidebar, select the virtual machine you want to clone.
3. Start Create Virtual Machine Template Assistant by doing one of the following:
   - Choosing **Clone to Template** from the **Virtual Machine** menu.
   - Right-clicking the virtual machine in the sidebar, and choosing **Clone to Template** from the shortcut menu.
4. In the Create Virtual Machine Template Assistant **Introduction** window, click **Continue**. To skip this window next time you start the assistant, select **Always skip introduction**.
5. In the **Name and Location** window, specify the name and location for the virtual machine template, and click **Clone**. You can use the **Choose** button to change the location.

By default, the virtual machine template files are placed to the following folders:

- On Mac OS X: `/Users/Shared/Parallels/<Virtual_Machine_Template_Name>`
- On Windows: `C:\Documents and Settings\All Users\Documents\Parallels\<Virtual_Machine_Template_Name>`
- On Linux: `/var/parallels/<Virtual_Machine_Template_Name>`
- On servers running Parallels Server Bare Metal: `/var/parallels/<Virtual_Machine_Template_Name>`
- On servers running Parallels Server Bare Metal Xserve Edition: `/var/parallels/<Virtual_Machine_Template_Name>`
6 In the **Creation Finished** window, click **Done** to quit the assistant.
Deploying a Virtual Machine Template

The virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual machine, you should create a virtual machine that will have the same configuration the template does.

There are two ways of creating a virtual machine from a template:

- convert the template to a virtual machine
- deploy the template to a new virtual machine

If you convert a virtual machine template into a virtual machine, the template is moved from the Templates list to the virtual machines list.

If you deploy a virtual machine template to a virtual machine, Deploy Virtual Machine Template Assistant (or Deploy Virtual Machine Template Wizard if Parallels Management Console is installed on a Windows- or Linux-based physical computer) creates a new virtual machine, but the template is not removed from the Templates list.

To convert a virtual machine template into a virtual machine, select this template in the sidebar and do one of the following:

- choose **Convert to Virtual Machine** from the File menu
- right-click the template's icon and choose **Convert to Virtual Machine** from the context menu
- click **Convert to Virtual Machine** in the Operations section of the template's Summary tab

The virtual machine template will be moved from the templates list to the virtual machines list.

To deploy a virtual machine template to a new virtual machine:

1. In the sidebar, select the virtual machine template you want to be deployed to a new virtual machine.
2. Start Deploy Virtual Machine Template Assistant (or Deploy Virtual Machine Template Wizard if Parallels Management Console is installed on a Windows- or Linux-based physical computer) by doing one of the following:
   - choosing **Deploy to Virtual Machine** from the File menu
   - right-clicking the template's icon and choose **Deploy to Virtual Machine** from the context menu
   - clicking **Deploy to Virtual Machine** in the Operations section of the template's Summary tab
3. In the Name and Location window, specify the name and location for the virtual machine. You can use the Choose button to change the location.

By default, the virtual machine files are placed to the following folder:

- On Mac OS X: /Users/Shared/Parallels/<Virtual_Machine_Template_Name>
- On servers running Parallels Server Bare Metal: /var/parallels/<Virtual_Machine_Template_Name>
On servers running Parallels Server Bare Metal Xserve Edition:
/var/parallels/<Virtual_Machine_Template_Name>

To make the virtual machine Windows security identifier (SID) different from that of the virtual machine on which the template is based, select **Change Windows SID**. It will help you to avoid possible security problems.

Click **Deploy** to start deploying the template to a new virtual machine.

4 In the **Deployment Finished** window, click **Done** to close the assistant.
Index

A
- About Parallels Management Console - 5
- About This Guide - 6

C
- Checking System Requirements - 10
- Cloning a Virtual Machine - 34
- Configuring a Virtual Machine - 30
- Connecting to a Server - 18
- Creating a Virtual Machine - 20
- Creating a Virtual Machine Configuration - 21
- Creating a Virtual Machine Template - 39

D
- Deleting a Virtual Machine - 36
- Deploying a Virtual Machine Template - 41
- Documentation Conventions - 6

E
- Exploring Parallels Management Console Interface - 15

F
- Feedback - 8

G
- Getting Help - 7

I
- Installing a Guest Operating System - 23
- Installing Parallels Management Console - 13
- Installing Parallels Tools - 24
- Installing Parallels Tools in Linux - 28
- Installing Parallels Tools in Mac OS X - 25
- Installing Parallels Tools in Windows - 27
- Introduction - 4

M
- Managing Virtual Machine Templates - 38
- Managing Virtual Machines - 31

O
- Obtaining Parallels Management Console - 12
- Organization of This Guide - 6

P
- Pausing and Suspending a Virtual Machine - 32
- Performing Basic Operations in Parallels Management Console - 20

S
- Setting Parallels Management Console to Work - 9
- Starting and Stopping a Virtual Machine - 31
- Switching View Modes - 33

U
- Uninstalling Parallels Management Console - 19